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Overview 
A database is a structured set of stored information (data) that 
can be readily organized, updated, searched through, sorted 
and analyzed.  A database can consist of one table, such as a 
mailing list that contains the names and addresses of several 
individuals, or many tables that, together, contain a range of 
information about a given topic.  For example, a database 
system storing information about college students might include 
several related tables, each pertaining to a particular type of 
information such as student identification, contact information, 
academic standing, or program of study. 

Records, Fields, and Values 
A database file is composed of R ecords , or sets of information 
about a particular subject.  Typically a record is one entry within 
the database.  Each entry or each record is comprised of 
F ields .  A field is the place where each piece of information –
first name, last name, and street address – is stored.  A field 
remains blank until a Value, the actual data, is entered into it. 

Creating and Opening Files 
Once FileMaker Pro opens, the New Databas e box 
appears.  From this box choose to create a new 
database file using a template, create a new empty file, or open an 
existing file.  Once an option has been chosen, click OK .  

Defining the Database 
If a new empty file was selected for creating a new database, the 
Define Database window appears.  Use this window to create fields, tables, and 
relationships. 

Defining Fields  
To create a new field: 

• Select the F ields  tab. 
• In the F ield Name field, type a field name. 
• Select a T ype. 
• Click C reate. 

When defining fields, there are eight types of fields to choose from.  The field type should correspond to 
the type of information that will be entered into the field.  The table below describes which field type to 
use for which type of data. 

Field names should not contain the following symbols or words: ,(comma), +, -, *, /, ^, &, =, >, <, (, ), “, :, 
::, AND, OR, XOR, NOT, or a FileMaker Pro function name (ex., SUM, WORDCOUNT, AVERAGE).  Also, 
do not begin a field name to be used in a calculation formula with a period (.) or a number. 
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F ield T ype P urpos e 

Text Letters, symbols, and numbers used as text.  FileMaker Pro allows up 
65,000 characters in a text field. 

Number Numbers or other characters, of which only the numbers will be treated as 
numeric.  You may enter up to 255 characters in a number field. 

Date 
Dates only.  A date field must include at least the day and month portion of a 
date.  If no year is entered (and a separator character for a year has not 
been typed), FileMaker Pro enters the current year for you. 

Time Times only.  A time field can contain the hours, minutes, and/or seconds’ 
portion of a time. 

Container A graphic, sound, QuickTime movie, or OLE (Object Linking and 
Embedding) object. 

Calculation The result of a formula that uses field values from the current record or 
related records. 

Summary A value that’s produced by summarizing field values from more than one 
record in the same file. 

Global One value to be used in all records of the file.  

 

Automating Data Entry 
To improve the speed and accuracy of data entry, you can set field options to automatically enter data in 
a given field.  For example, if the majority of records for a mailing list file contain entries for people who 
reside in New York State, FileMaker Pro can automatically enter “NY” in the appropriate field.  

In the Define F ields  tab, click the field to set options, and click the Options … button.  Select the check 
box that corresponds with the data to automatically be entered in the field.  For the example above, check 
the box labeled Data, and type “NY” in the box that follows.  

To change Auto-Entered data in a record, highlight the data and type its replacement value.  To prohibit 
Auto-Entered data from being changed, select P rohibit modification of value when specifying field 
options. 

Creating Tables 
Tables contain different sets of fields and records.   Create a new table if the database is designed to 
house different kinds of information about the same person or object.  For example, if creating a database 
about students, one table may contain the students’ contact information, while another table may contain 
information about their major and advisor. 

To create a new table: 

• Select the T ables  tab. 
• In the T able Name field, type a name for the table. 
• Click C reate. 

Defining Relationships 
If multiple tables are used, relationships should also be defined.  Relationships allow fields to be linked 
together from one table to another.  A name or identification number are common fields that would be 
defined in a relationship.  Relationships allow related information to be shared between different, discrete 
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tables.  Common fields in each table allow FileMaker Pro to interpret this information and display it in a 
portal.  See the Portals section below, for more information.  

To create a new relationship: 

• Select the R elations hips  tab. 
• Highlight the field name to be linked from the first table. 
• Drag the highlighted field to the fieldname in the second table. 

Once the database has been defined, click OK  to close the Define Database window. 

If the database needs more fields, relationships, or tables at a later time, the Define Database window 
can be accessed by going to F ile  Define  Databas e. 

Modes  
There are four different ways of working with data in FileMaker Pro, which allow specific tasks to be 
performed.  To switch between modes in FileMaker Pro, go to the View menu and select the appropriate 
mode for the desired task.  

The table below shows which mode to use for which kind of task.  

 

Us e this  mode T o 

Find Search for a record or a group of records that match the 
criteria you specify. 

Layout Determine how information is displayed on the screen or 
printed in reports, labels, and forms. 

Preview See how the information will look before printing. 

The Toolbars 
By default, FileMaker Pro displays the Standard toolbar.  There are a total of four toolbars within 
FileMaker Pro (Standard, Text Formatting, Arrange, and Tools).  Depending on the mode, there are 
different toolbars available to use.  To view the available toolbars, go to V iew  T oolbars  and select the 
toolbar to use.  The Arrange and Tools toolbars contain shortcuts to all options contained in the Ins ert 
and Arrange menus and are only available in the L ayout mode. 

T he S tandard T oolbar contains shortcuts for creating and opening databases, along with data entry and 
manipulation.  
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T he T ext F ormatting T oolbar can be used to change the font and the size of the text within the 
database.  Similar to Microsoft Word, this toolbar allows the font, size, weight, and justification of text to 
be selected.  

The Status Area 
The Status Area is the gray column to the left side of the FileMaker 
Pro window.  This column changes according to the mode.  In Browse 
mode the Status Area allows switching between modes, layouts, and 
records.  

To move to the next or previous record, click the book in the status 
area while in Browse mode.  Move to a specific record by typing the 
record number in the R ecord field and press E nter.  

Working with Records 
Entering Data 
After defining the fields for your database file, FileMaker Pro enters 
the B rows e mode and creates a layout for entering data.  Type the 
data into corresponding fields, using the T ab key or the mouse to 
move through fields.  

To enter new records, click the New R ecord button from the Standard Toolbar.  

To delete records, irretrievably discarding the data contained within, click the Delete R ec ord button from 
the Standard Toolbar. 

Sorting Records 
FileMaker Pro stores records in the order that they were added to the database.  When working with 
records it is often useful to s ort or rearrange records in a different order.  

Sorting can occur in the Browse or Preview modes.  To perform a sort, go to R ec ords   S ort….  In the 
S ort R ecords  dialog box, click the field to sort by, select the order (ascending, descending or custom), 
and click the Move button.  Repeat these steps to add additional fields to the sort order.  

The sort will be performed according to the sort order of the fields, from the top of the list to the bottom.  
To change the sort order, click on the double-headed arrow to the left of the field name and drag the field 
to its new location.  Remove a field from the sort order by highlighting the field and choosing C lear.  After 
fields are in the chosen order, click the S ort button to sort the records.  Unsort a group of records by 
choosing S ort… from the R ec ords  menu and clicking on the Uns ort button.  

Find Mode 
To search for records matching specific criteria, switch to the F ind Mode from the View Menu.  Once a 
search has been performed, FileMaker Pro returns to Browse mode and displays the found set, or 
records that match the specified search criteria.  All other records are temporarily hidden. 

To perform a search, enter the value(s) in the appropriate field(s).  

Note:   Search criteria cannot be entered in container fields, summary fields or global fields.  

Values entered into a find request can be combined with operators from the S ymbols  menu found in the 
Status Area.  Once search criteria has been entered, click F ind in the status area. 

To display all of the records in a file, choose S how All R ecords  from the R ecords  menu.  
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To find records that match either of two criteria for the same field:  enter the first criterion as described 
above, and then go to R eques ts   Add New R eques t, enter the second criterion, and click F ind.  

To delete the request go to R eques ts   Delete R eques t.  

To repeat or edit the most recent search request, go to R eques ts   Modify L as t F ind.  

To repeat the request, select this option and then click F ind.  

To edit the request, make the necessary changes before clicking F ind.      

Layout Mode 
In FileMaker Pro, a layout determines how information is displayed and printed.  While a layout controls 
the appearance of data, a layout does not store data.  For one file, separate layouts can be designed for 
different tasks.  For example, there can be one layout for entering data, another for searching for 
information, and another for organizing reports. 

Changing a layout’s design does not affect the actual data.  Changes made to data in one layout will be 
reflected in all layouts that display the data.  To change between different layouts in FileMaker Pro, go to 
the L ayouts  drop-down menu located in the Status area and select the desired layout. 

Creating Layouts 
To create a layout, switch to the L ayout Mode and: 

1. Go to L ayouts   New L ayout/R eport… 

2. In the New L ayout/R eport dialog box, type a name and choose a type of layout to create.  To have 
the layout listed in the Layout menu when using other modes, check the box marked Inc lude in 
layouts  menu.  

3. Click OK .  

FileMaker Pro includes predefined layouts that can be used for such purposes as displaying data in a 
columnar report or printing mailing labels.  Predefined layouts can be used as they are, or modified to suit 
other needs.       

Layout Parts 
FileMaker Pro layouts are divided into parts, which are areas in 
a layout that help determine how information is displayed and 
printed.  Layout parts include headers and footers, summaries, 
and the body.  To add a part to the layout, go to Ins ert  P art.  

In the layout mode two more toolbars become available, the 
T ools  and the Arrange toolbars.  To view these toolbars go to 
View  T oolbars  and select T ools  and Arrange.  The T ools  
toolbar contains shortcuts to options that are found under the 
Insert Menu.  The Arrange toolbar contains shortcuts to options 
that are found under the Arrange Menu. 

Working with Objects in a Layout 
In the status area, the T ool P anel is displayed.  This panel 
allows the formatting of objects in the layout. The tool panel can 
be used to move and resize objects, adjust fill and pen settings, 
and add fields, text and borders.  To add objects to a layout 
using the tool panel, click the tool to select it.  Then, on the 
layout, click and drag the object to the desired size and position.  
Double-click on a tool to keep the tool selected until you click on 
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another tool. 

Duplicating, Deleting & Renaming Layouts 
To duplicate a layout, choose the desired L ayout, and go to L ayouts   Duplic ate L ayout.  

To delete a chosen layout, go to L ayouts   Delete L ayout and click Delete in the confirmation 
box.  

Note:   Deleting a layout cannot be undone.  

To rename a chosen layout, go to L ayouts   L ayout S etup.  

Type a new name in the Name field, and click OK . 

Arranging Layout Elements 
Within the Arrange menu, different options can be chosen to change the layout of fields.  In order to 
arrange the fields first select the desired fields. 

To select multiple fields, press S hift and click the desired fields.  

Portals 
Portals are specialized layouts that allow information to be displayed from multiple tables.  In order to 
create a portal, a relationship must be defined first. 

To create a portal: 

1. Go to L ayouts   New L ayout/R eport. 

2. Title the layout and select “Standard Form” as the type and click Next. 

3. Select the appropriate display options and click Next. 

4. Highlight the desired fields and click Move to add them to the report.  Click Move All to add all the 
available fields to the report. 

In the drop-down menu, change the table and select the related information to be added to the layout. 

Generating Reports 
Reports are customized lists of data from the database.  Reports can be used to summarize or print and 
archive relevant information contained within the FileMaker Pro database. 

To create a report:  

1. Go to L ayouts   New L ayout/R eport. 

2. Title the layout and select “Columnar list/report” as the type and click Next. 

3. Select the appropriate display options and click Next. 

4. Highlight the desired fields and click Move to add them to the report.  Click Move All to add all the 
available fields to the report. 

5. Change the desired order of the fields by clicking the double-headed arrow and dragging the field to 
the appropriate location and click Next. 

6. Set the sort options for the report and click Next. 

7. If the report is to be printed, select the Default theme, otherwise, select a theme and click Next. 

8. Choose what should appear in the header and footer of the report and click Next. 
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9. Select “Create a Script” and give the script a title. This will allow faster access to viewing and printing 
the report in the future.  Once the script has a title, click Next. 

10. Select “View the report in Preview Mode” and click F inis h. 

Once the wizard has finished, the report will appear on screen.  To make modifications to the report, 
return to the Layout mode.  This will allow the report to be modified and formatted according to need.   

Sharing and Securing Databases 
FileMaker Pro databases can be shared over the network in order for different users to work 
simultaneously with other users.  By default there are two users predefined for each database, an Admin 
user and a Guest.  The Admin is the first person to open the file and has full access to the database.  The 
Guest account, by default, can only read the database and cannot make modifications to it.  These 
accounts can be password protected for security. 

To make changes to these accounts, go to F ile  Define  Ac counts  and P rivileges …  A window will 
appear, allowing accounts to be added, deleted, or modified. 

To password protect the Admin account: 

1. Go to F ile  Define  Ac c ounts  and P rivileges … 

2. Select the Admin account. 

3. Click E dit. 

4. Type a password for this account. 

5. Click OK . 

For More Information 
A variety of support services are available from ITS if you would like additional help: 
 
Computer training on a variety of topics is available to faculty, staff, and students at no charge through 
the Technology Learning Center (TLC). Check out the current TLC training schedule online at 
https://www.ithaca.edu/its/workshops  
 
Online documentation and tutorials on IC-supported computing software and systems are available at 
https://www.ithaca.edu/its/traindoc 
 
Frontline computing support is available through the ITS Helpdesk in 104 Job Hall; send e-mail to 
helpdesk@ithaca.edu or call 607-274-1000. 
 
Backline consulting support is available in the Technology Learning Center, room 101 Friends Hall. 
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